Chapter 1

Building Your First Report

EVERY BUSINESS THAT STORES data has a need to retrieve that data and build good reports.
Organizations don't typicaﬂy store data without reason. . .business intelligence (BI) is the reason,
and reporting is the process of creating that business intelligence.

The process begins with locating the stored data. Sometimes this is an easy task; sometimes it
is not. Crystal Reports can help you easily connect to your data. The next part of the task is to
identify and format the pieces of data you need to answer a business question. A data customer
will never come to you and say, “Hey, can you build a report with five fields, a graph, and a title?”
Instead, they’ﬂ ask you if you can build a report to answer a business question, for instance, “How
many five-star resorts do we have in our inventory?” The focus for users of data is on the business
inteﬂigence it provides, not on the data itself.

This makes your job similar to that of a good detective. You piece together all the clues using
data and tell your audience at the end of the process “whodunit” using summary information and
visual elements. Your job as the report designer is to convert business requests into the nuts and
bolts of a report.

Featured in this chapter:

Using a wizard to choose a report gallery style
Choosing a data source

Adding and formatting fields

Grouping information

Sorting information

Adding summary information

Understanding the report design area
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Using the toolbars and menus
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Setting Up the Right Report

In this first chapter, we have a simple goal: build a report. We'll take advantage of the built-in creation
wizard in Crystal Reports and explain all the fundamentals along the way.

You can think of a report as the answer to a business question. Users, customers, and peers come
to you with a question about their inventory, their sales, their competition, their expenses, and so on.
Your answer gives a glimpse into the state of the business, and as a Crystal Reports developer, your
job is to find the data and craft a report that answers their question.

To this end, whenever we build a report in this book, we'll first state the business question that
the report you create will answer, as shown here:

Business Question: How many resorts does VistaNations bave in each country and what are their
names?

Okay, we're ready to go! The VistaNations folks have a Microsoft Access database for us to use.
To get started with Crystal Reports 9, you may have a desktop icon you can double-click or you can
use the following menu sequence: Start > Programs > Crystal Reports 9.

NOTE Al menu sequences will be called out in this way. A Windows 2000 desktop environment is assumed, so your
actual command sequences may vary slightly.

The Crystal Reports Welcome screen, shown in Figure 1.1, appears, and now you have to make
your first decision.

FIGURE 1.1

Cl‘yStal Reports — Create a Mew Crystal Report Document
Welcome screen oo';% ' Using the Report 'wizard

D " 45 a Blank Report

@ {+ Open an Existing Repart

V' Show welcome dialog at startup

QK I Cancel | Help |

The top half of the screen provides radio buttons with choices on how to build your report:
¢ Using The Report Wizard
¢ As A Blank Report

The bottom half of the screen displays a radio button to open existing report files. When a report is
saved in Crystal Reports, it is saved as an operating system file with the three-letter file extension .RPT
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for report. If you choose the radio button to open an existing report, you can choose from files shown
in the file list directly below the radio button or you can click More Files to browse to any existing

RPT file.

TIP  Notice the check box at the bottom of the window to show the Welcome dialog at startup. Uncheck the option to prevent
this partimlar window from displuying in the futwe‘ You can access the window in the futwe by cboost’ng the menu options

Help > Welcome Dz’alog,

At this point, wee going to use the Report Wizard, shown in Figure 1.2, by selecting the first
radio button, Using The Report Wizard, and dicking the OK button. The Report Wizard provides a
guide for adding key components to a report in a step-by-step manner. In later chapters, we'll revisit
this screen and learn how to build a blank report.

FIGURE 1.2

Using the Report Create a Mew Crystal Report Document
Wizard oo';% & Using the Report 'wizard

D " 45 a Blank Report

TiP V%lﬁdeszgned applications for Mifrosg‘t Windows genemlly provide an OK button for you fo click to af/enowledge

the acceptance g‘ cbanges made to a dialog and to move forward in the applimtion.

The bottom half of the Report Wizard screen is updated and presents a list of four typical report
wizards in the Report Gallery shown in Figure 1.3.

FIGURE 1.3 r Chaose a'wizard
Standard

Report Gallery

Guides the creation of a typical report.

QK I Cancel | Help |

Choosing one of the report types tells Crystal the physical layout to use to present the informa-
tion. The Standard Report Creation Wizard is the most commonly used report type. Each of the
report types is described in Table 1.1.
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TABLE 1.1: TYPES OF REPORTS

WIZARD

Standard Report Creation
Cross-Tab
Mail Label

OLAP

REPORT DESCRIPTION

A report consisting of rows and columns of data
A report consisting of a table of summarized information
A report formatted to wrap data across multiple columns

A report consisting of a summarized grid of data retrieved from an Online
Analytical Processing database

For this example, we'll use a standard report, which is selected by default since the Standard Wizard
is the first one in the list. Click OK to accept the options presented.

Choosing a Data Source

The next step in building a report is to select the data that will be used to populate your report. The
Standard Report Creation Wizard dialog, shown in Figure 1.4, allows you to choose your data source.

FIGURE 1.4 I standard Report Creation Wizard [ %]
Available data Data a
sources Chooze the data you want to report on,
Available Data Sources: Selected T ables:
- [ Current Connections

(CARepository

D History
E-[Z Create New Connection o |

(ZA Crystal Queries ]

([ Database Files ;I
(23 Dictionan /A rfoview o
[CA0DeC (ROO) _I
CA0lap

[CAOLE DE [200)

-2 More Data Sources

< Back I Mext » I Finizh Cancel Help

Available Data Sources

The Data dialog contains a list of available data sources on the left side of the window. Crystal
Reports 9 supports a long list of data sources. There’s a good chance the type of data youTe using
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will be listed directly; if not, you can use the Create New Connection option to access the database.
Table 1.2 describes the five general categories of data sources.

NOTE Tbmk g(“available dﬂm 501/11’565”615 bezng any dﬂtﬂbﬂé‘f or dﬂfﬂﬁl{? ZOL’LUE!Z7 on your ma(bine or llf[ESSl'bZE f}}?’OMgb
a HEIWO‘fk connectionfrom your [Oﬂlp%t{??ﬁ

TABLE 1.2: CATEGORIES OF DATA SOURCES

SOURCE DESCRIPTION

Current connections Displays the databases to which Crystal Reports is currently connected.
Repository Lists data stored in Crystal’s common object repository.

Favorites Displays a list of databases that you have manually added to your Favorites.
History Shows data sources you have recently used; during the current Crystal session, all

databases you access will appear; once closed and reopened, Crystal displays the
most recent five data sources.

Create new connections Allows a connection to any data source that you can access.

The process of specifying data for your report is to select a data source from the window on the
left (Available Data Sources) and use the arrow in the middle to move your selected data source to

the window on the right (Selected Tables).

NoTE The + Ct)lus stgn) to the lgft qf a word or pbmse indicates that this is an expandﬂble category that contains
submtegories) as shown p‘feviously in Figure 1.4.

The VistalNations organization uses a Microsoft Access database. In the collapsed format, the
Standard Report Creation Wizard does not list the VistaNations database, so we need to go and find
it. This will often be the case in your organization. . .finding the data can be an adventure!

Making a New Connection

Since we know the data source is a Microsoft Access database and we haven't worked with it before,
the option to create a new connection sounds promising. In fact, whenever you start working with a
database you haven't used previously in Crystal Reports, this is your starting point. Once you make a
connection to a database, it appears directly in the list. Double-clicking the Make New Connection
option opens the Connection dialog shown in Figure 1.5.

The Connection dialog provides an area to specify the database name, the type of database youe
accessing, and whether you need to access the database with a user ID and password, in another
words, a secure logon.

The options to add a database password, a session user ID, a session password, and a system data-
base path become active and available only when the Secure Logon check box is marked.

Minimally, you can provide just the database name and its type to make the connection. You can
enter this information directly, browse to it, or use a drop-down list to help you.
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FIGURE 1.5
Connection dialog Connection

Flease enter connection information...

D atabase Mame: I _I
Databaze Type: IAccess j
Secure Logon: r

[ atatiase Passward: I

Session [serlD: I

Session Fazsword: I

Spstem Database Fath; I _I

< Back | [dext > | Finizh I Cancel | Help |

Let’s find a database using the browse button (the button with three ellipsis points on it). The
browse button brings up a dialog window to let you find and open any data file. In our example, the
VistaNations database is located directly on the Local Disk (C:), as shown in Figure 1.6.

FIGURE 1.6 Open HE

Open dialog & & ef EE-

Look in:

ADOBEAPP [ETT
CR9 18] vistaMations.mdb
crslz6

Docs

Documents and Settings

Fullshotaa

IDAPT

Oracle

Program Files

RASY

ternp

File name: | Open I
Filez of type: IData Files j Cancel |

The VistaNations database is read-only and does not require any userID or password, so we’ll
leave the Secure Logon check box unmarked. Figure 1.7 shows the database name and database type
propetly filled in, so you're ready to click the Finish button to make the connection.



FIGURE 1.7
Connection settings Connection

Flease enter connection information...

CHOOSING A DATA SOURCE

D atabase Mame:

Databaze Type:

Secure Logon: r

C:AigtaM ations. mdb

|

[ atatiase Passward: I

Session [serlD: I

Session Fazsword: I

Spstem Database Fath; I

]

cBack | Hews | Finsh |

Cancel | Help |

This completes the task of choosing a data source. The VistalNations data source now appears in
your list of Available Data Sources, as shown in Figure 1.8, and you’re ready to choose tables and fields.

FIGURE 1.8

An available data
source

Choosing a Table

Awailable Data Sources:

D Current Connechions

-2 Repositorny

[:I Favorites

+- (2 Histary

B3 Create New Cannection

23 Access/Excel (DAD)

43 Make New Connection
{ ndb

- [C Crystal Queries
#-ZA Database Files
- (23 Dictionanrfoview
E-CA0DBC(RDO)
-3 00ap
&-(A0LE DB [2D0)
[]--D Mare Data Sources

Database software (such as Microsoft Access) stores data in files that can contain any number of data-
base tables. Within each table, any number of fields can be stored. The typical database components
are depicted in Figure 1.9. Microsoft Access stores its data in a file that has an .MDB extension.
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FIGURE 1.9 Database
Database
components

| Table2

Table1

The Data dialog shown in Figure 1.10 shows a list of Available Data Sources on the left and a list
of Selected Tables on the right: the tables you have selected to use in this particular report. When
you begin a new report, this list is empty.

FIGURE 1.10 i Standard Report Creation Wizard
Data dialog Data

Chooze the data you want to report on,

Current Connections

The VistaNations organization has several tables in its database; we’ll build a report with one of
them. By clicking a table, for instance, Resorts, you select that table from the list of Available Data
Sources. With a table selected, the buttons in the middle become active. A single click on the first
button copies the table to your Selected Tables list, as shown in Figure 1.11.
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FIGURE 1.11
Selected table Data D\EI

Chooze the data you want to report on,

Available Data Sources: Selected T ables:
- (3 Current Connections = B & C:WWistaM ations. mdb
(1 Repository L Resorts
-[CA Favorites
D History

B[ Create New Connection
53 Aceess/Exncel (DAD]
3 Make Mew Connectior
@; C:AigtaM ations. mdb

-#4] Add Command
AmenitiezByR ezort
AmenitiesBylnit |
AreazlnRegions

bl LD

Owners
Fegions
Resorts
UnitDescription
- | v
< Back | Mext » | Finizh Cancel Help

DIALOG BUTTONS

Let’s spend a moment discussing the Crystal-specific behavior of the five button options at the middle of
the Data dialog. The first button, Back, is grayed out (disabled), signaling that moving to the previous dialog
is not an option at this point. This is common practice in applications written for Microsoft Windows.

The Next button is available, and it is the button you use to move step-by-step through the Report Creation
Wizard. So, the Back and Next buttons move you in either direction through the Report Creation Wizard.
The nice thing about this is if you want to change one of the choices you’ve made during the creation
process, simply use the Back button to go back and correct the option and the Next button to return to where
you were and keep going.

The Finish button is also active and available. The behavior of the Finish button in Crystal is to stop the
wizard at any point you choose, take the information collected up to that point, and use it to create and
display the report. That means you don’t have to use all the screens in the wizard in order to create a
report! As a point of reference for when to do this, though, take note that if you were to click Finish at this
point, you’d have a pretty dull report since you haven’t chosen any field data.

The Cancel button also stops the wizard, halting the report-building activity completely and closing all
open dialogs. The behavior of the Cancel button should be familiar to you Windows users out there!

The Help button opens a context-sensitive help window. An appropriate help window for the task you are
doing will appear. Crystal Reports 9 has a very complete help file and provides a wealth of information. This
feature has been vastly improved in Crystal Reports 9, so enjoy!
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NOTE  After the wizard completes and you are in the Crystal Reports design environment, you can add additional tables
or change your data source altogether using the toolbar. Notice the icon in the top-right corner of the Data dialog, shown in
Figure 1.11. This icon will appear on the Crystal Reports toolbar later.

Adding Fields

With a data source’s table identified, the Report Creation Wizard next guides you to choose fields
from the table to add to the report using the Fields dialog shown in Figure 1.12.

FIGURE 1.12 I standard Report Creation Wizard ]
Choosing fields Fields -%
Chooze the information to dizplay on the report,

Available Fields: Fields to Dizplay: &S v
=1-[28] Resarts

- = Region

2= Resorth ame
2= Streetdddress
=3 ity

2= StateProvince
-2 Country

=1 PostalCode o
=1 ResortPhone
- =3 FiveStarF ating

EX

LB

Browse Data... | Find Field... |

< Back I Mext » I Finizh Cancel Help

Choosing Fields

The Fields window should feel familiar since it is similar in design to the previous dialog we examined.
Your job s to select fields in the list of Available Fields on the left side of the dialog and copy them to
the right side of the dialog, Fields To Display, using the buttons between the two lists. Referencing the

business question, we'll choose appropriate fields from the 10 available in the Resorts table.

Business Question: How many resorts does VistaNations have in each country and what are their
names?

To satisty this business question, we'll need the following fields:
¢ ResortName

¢ Country
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You can click each field individually to select it and then use the first button between the two lists
to copy the field to the list of Fields To Display. When you've finished adding fields to the list of
Fields To Display, you can click Next to move to the next step.

NOTE Tl first two buttons shown in Figure 1.12 move fields to the list of Fields To Display; the second two buttons
in Figure 1.12 (shown disabled bere) remove fields from the display list.

TIP  You can use the Microsg‘t keyboard shortcuts Ctrl or Skg‘t while selecting fz‘elds fo }){gbltgbt individual or adjacent
ﬁelds as a group.

Browsing Data and Finding Fields

There are two buttons on the Fields dialog: Browse Data and Find Field. The Browse Data field is
used to take a peck at the type of data that is stored in the field before adding it to your report. For
instance, with the Country field selected in the Available Fields list, chcking the Browse Data button
displays sample data and tells you what type of data is stored. Figure 1.13 shows the Browse Data
window for the Country field. You can scroll through the list box to view the data that is stored in
the field. Along the top, you can see that the field data type is String and its length is 50.

FIGURE 1.13

Browse Data window

Type: String
Length: B0

The Find Field button is useful when a long list of fields is displayed and you want to avoid
scroHing to find a particular field. You can type in the exact name of the field you’re Iooking for or
as much of the name, starting at the beginning, as you know, as shown in Figure 1.14.

FIGURE 1.14 Enter Search Name
Find Field window I_
[Countny

oK I Cancel |
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Sequencing Fields

With a set of fields to display shown in the Fields dialog, you can determine the order in which the
fields are added to the report. Click the upward- or downward-pointing triangle, visible here in
Figure 1.15, to move the selected field higher or lower in the list of fields.

FIGURE 1.15 Fields to Display: A v

Sequencing fields = Resorts. Resothame
= Resorts. Country

NOTE  After the wizard fompletzs and you are in the Crysml Reports design environment, you can still add fields using
the toolbar. Notice the icon in the top-right corner of the Fields dialog, shown previously in Figure 1.12. This icon will appear
on the Crystal Reports toolbar later.

Grouping and Sorting Information

The Grouping dialog follows the same familiar approach of selecting items from the left and copying
them to the right. On the Available Fields list, however, there are now two categories, as shown in

Figure 1.16.

FIGURE 1.16

Grouping the Grouping —
information [Optional] Group the information on the report, —
Available Fields: Group By: &S v
Feport Field:

2a

i..e= Resorts, Country > |
Resorts
=1 ResortCode LI

- = Region

2= Resorth ame

2= Streetdddress ;I
=3 ity v |
2= StateProvince

-2 Country

=1 PostalCode

=1 ResortPhone

- =3 FiveStarF ating

Browse Data... | Find Field... |

L

< Back I Mext » I Finizh | Cancel | Help |

TIP  Navigate to the Grouping and Sorting dialog using the Next button or by clicking directly on the tab.
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Choosing a Field to Group By
The first category of fields is Report Fields. You can think of these as the fields you've already asked
to be included in your report. The second grouping shows all the fields in the data source being used
for the report, including the ones from your report, meaning there is inherent duplication.

If you choose a field to group by that is not represented by the Report Fields category, the new
field will be automatically added to the list of fields that display in your report.

Business Question: How many resorts does VistaNations bave in each country and what are their
names?

Our business question requires that we determine how many resorts are in each country, so we'll
create a grouping based on the Country field. We select the Resorts.Country field from the list on
the left and use the buttons in the middle to copy the field to the Group By list on the right, as
shown in Figure 1.17.

FIGURE 1.17
Group By Country Grouping =

[Optional] Group the information on the report, —

Available Fields:
EQ, Feport Fields
= Resorts. R esorth ame

= Resorts. Country
E-E) Resarts

=1 ResortCode

- = Region

2= Resorth ame
2= Streetdddress
=3 ity I
2= StateProvince
-2 Country

=1 PostalCode
=1 ResortPhone
- =3 FiveStarF ating

EX

bl kL

Browse Data... | Find Figld... | Iin ascending order. j

< Back I Mext » I Finizh | Cancel | Help |

Sorting a Group

By default, a group is sorted in ascending order. The sorting drop—down box is located at the lower right

of the Grouping dialog (see Figure 1.17). You can change the sort order to descending if you wish.
The -A to the right of the field name in the Group By list tells you that the Resorts.Country field

will be sorted in ascending order; -D would appear for descending order.
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NoOTE  After the wizard fompletes and you are in the C1y5ml Reports design environment, you can still add Qroups using
the toolbar. Notice the icon in the top~right corner of the Grouping dialog, shown in Figure 1.17. This icon will appear on
the Crystal Reports toolbar later. Notice also that this part of the screen identifies grouping as an optional step. This is the
first time you’ve seen this feature in the Report Creation Wizard. The icon is a signal to you that you can expect reasonable
results at any point when you click the Finish button.

Summarizing Data

After grouping the fields, the Report Creation Wizard helps you summarize the data you've selected.
If you've grouped the data, the fields involved in the grouping are automatically added to the Sum-
marized Fields list. The Summaries dialog is shown in Figure 1.18. To summarize data, you choose a
field to summarize and a summarization method.

FIGURE 1.18
Summaries dialog Summaries

[Optional] Add summary information ta the report.

)2

Available Fields:

Feport Fields

Summarized Fields: &S v

=&

> | ‘2 Resorts. Country

: = Resorts. Country
=] Resorts

----- = ResortCode
..... = Region

----- = Resorth ame
----- = Sheetdddress
..... = City

----- = StateProvince
..... = Country

----- = PostalCode
----- = ResortPhone
----- = FiveStarFating

| i
Browse Data... | Find Field... |
< Back I Mext » I Finizh | Cancel | Help |

Business Question: How many resorts does VistaNations bave in each country and what are their
names?

Our business question requires that we count how many resorts are in each country. Count is a
summarization method. We will summarize based on the Country field using a count summarization,
We select the Country field from the list on the left and copy it to the list on the right using the but-
tons between the two lists.

A default summarization method will be automatically set for you, as shown in Figure 1.19, but
you can change to another type of summarization method by selecting it from the drop-down list.
The default method set is based on the type of data contained in the field you are summarizing.
Table 1.3 describes each of the summarization methods.
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FIGURE 1.19 O standard Report Creation Wizard E
Summarization Summaries 2
defauh [Optional] Add summary information ta the report.

Available Fields: Summarized Fields: an v

‘2 Resorts. Country

E-& Report Fields
i L.m3 Resorts ResotMame 00 =====T| . I Max of Resorts. Country

--m= Resorts.ResotMame

¢ hem3 Resorts.Country
=] Resorts

----- = ResortCode
..... = Region

----- = Resorth ame
----- = Sheetdddress
..... = City

----- = StateProvince
..... = Country

----- = PostalCode
----- = ResortPhone
----- = FiveStarFating

IMaximum j
Browse Data... | Find Field... |
< Back | Mext » | Finizh | Cancel | Help |
i
TABLE 1.3: SUMMARIZATION METHODS
SUMMARIZATION DESCRIPTION
Maximum Given a set of values, returns the largest value
Minimum Given a set of values, returns the smallest value
Count A number representing how many times the value appears in the field
Distinct Count A number representing how many times the value uniquely appears in the field
Mode Given a set of values, returns the value that occurs most frequently in the field
Nth largest, N is: Type a value for N as an integer number (e.g., 5) and from a set of values in the

report, Crystal returns the N largest values (in this case, the 5 largest values)

Nth smallest, N is: Type a value for N as an integer number (e.g., 7) and from the set of all values,
Crystal returns the N smallest values (in this case, the 7 smallest values)

Nth most frequent, N is: Type a value for N as an integer number (e.g., 9) and from the set of values in the
data source, returns the N most frequently occurring values; similar to Mode.

The summarization techniques available are determined by the data values stored in the field. To
answer our business question, the Count summarization method makes the most sense, as shown in
Figure 1.20. It allows you to summarize nonnumerical data by counting instances of a value.
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FIGURE 1.20

Count

summarization [Optional] Add summary information ta the repart.

method

Summaries 2

Available Fields: Summarized Fields: an v
EQ, Feport Fields
¢ =3 Resorts.ResortMame

(= Fesorts Courtry
------ X Count of Resorts. Country

fm@ Resorts. Country >

|
= Resorts
..... m= FesortCode |
..... m= Regioh .
..... = ResortMame |
<4
----- = Stresthddress
..... = [ity
----- m= StateProvince
..... o= Country
..... m= PostalCode
----- = ReszortPhone

----- = Foeiafas T

Browse Data... | Find Field... |

< Back I Mext » I Finizh | Cancel | Help |

4

Notice that the sigma symbol appears indented under the grouping symbol in the graphic above.

What this means is that the report will show a count for each unique grouping. For instance, if the

Country is Canada, there will be a number representing how many resorts are in Canada. Likewise, if

the Co

untry 1s the Unite ates, there will be a number representino how many resorts are in the
try is the United States, th IIb ber rep ting h y t th

United States. The indenting gives you a visual idea of how the summarization will be done in the

I‘CpOI‘t.

NOTE

After the wizard fompletes and you are in the C‘rystal Reports des{gn environment, you can summarize fz’eld data

using the toolbar. Notice the icon in the top~rtgkt corner of the Summaries dialog, shown in Figure 1.20. T his icon will

ﬂppt’ﬂ?’ 0

n t]?t’ C?:ySfﬂZ REPO?‘tS fOOlbﬂ‘f Zﬂtf?i

Creating the Reports
At this point you've done the following:
¢ Connected to a data source
¢ Chosen a table and fields to use in the report
¢ Created a group based on sorted field data
¢ Summarized data based on a field

You're ready to generate the report! To do this using the Report Creation Wizard, simply click the

Finish

button.
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The Report Design Area

The result of the Standard Report Creation Wizard is the generation of a report that is opened in
Preview mode in the Crystal Reports designer, as shown in Figure 1.21.

FIGURE 1.21 B} Crystal Reports - [Report10]

o [ Fl= Eci View Inseit Foma: Databass Repot Window Heb =l8x|
Previewing D@ -H[BEa 7|4 e o E Ol Ao =) |
the report il A =2 ¢z ul===c|a-E-=2a|s 5 %G %

RN EEY 1
|=ErsRaver2d |

Design | Freviow | Todap 1457 X W 4 Tair Y W=
| ' 1 ' H ' BE ' El [ [
i =
FH
Sh3izo0c
Cauntn Eesortiame
Andorra
- Angoma La Dorada Club Tarter
1 Andorra

- Club Flamingo
- Cprpus “
-~ Crech A
1 antilles
- Damnic,
- Dulch I_ argentina
Argentina Crystal Buites Aparrments
Al i Ll_l
[Records: 201 |10

Navigating the Report

How can you tell youTe in Preview mode? Well, the screen is quite busy, and we'll explore all of it
but let’s focus our attention on a horizontal area a third of the way down the screen under the tool-
bars (see Figure 1.21). This horizontal area contains the following:

¢ Tabs for Design and Preview mode

The current date and time

An X button you can click to close this report but stay in Crystal Reports

Forward and backward navigation buttons to move one page at a time through the report

First and last navigation buttons to move to the first page or last page in the report

* & & o o

An estimate of the number of pages in the report and the current page number

WARNING  The page count estimate is usually incorrect until you navigate through the pages directly. For instance, the
estimate in Figure 1.21 shows pages 1 of 1+. At this point, Crystal has made its best guess and knows that there is more
data than will fiton a sz‘ngle page, but it does not yet know how many pages will be reguired fo display it. Clifleing the forward

and bac/eward Z?MttOHS Wlll Mpdﬂ[{? t}JL’ pﬂgﬁ count estimator.
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Using Preview Mode

The intent of Preview mode is to display the data as the user of the report will see it. From Figure 1.22,
you can see that we have a column of data for Country and a column of data for ResortName, the
two fields we chose using the Report Creation Wizard. We grouped the data based on Country and

sorted it in ascending order, and sure enough our data is being displayed using these criteria.

FIGURE 1.22 513/200°
Preview mode
Country Eesorttame
Andorra
Andorra La Dorada Club T arter
1 Andorra
Antilles
Antilles Club Flamingo
1 Antilles
Argentina
Argentina Crystal Suites Apartments
1 Argentina

Notice that Crystal took care of arranging the fields in the report automaticaﬂy. While this was
thoughtful, 1t might not be aesthetidy pleasing, so rest assured that you can change it to your liking
in Design mode.

GROUP TREE

Whenever you perform grouping in your report, a group tree is displayed in Preview mode in the
Crystal Reports design area. The group tree is a vertical area that appears anchored to the left side of
the screen, as shown in Figure 1.23. It is used as a navigation technique to let the user jump to a par-
ticular group within the report.

By clicking a group name in the group tree, the data that appears in the preview area changes to
the data that references the chosen group. For instance, we clicked the text line Bahamas in the group
tree, and the display area moved the Bahamas group to the top of the screen, indicating that there are
two resorts in the Bahamas, as shown in Figure 1.24.



FIGURE 1.23

Group tree

FIGURE 1.24
Using the group tree
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The Design mode layout area is where you'll do most of your work. In this area, you rearrange, add,
and delete text, fields, and objects to create a visually appealing report. Notice in Figure 1.25 that we
don't see actual data in Design mode; instead, we see placeholders for fields, group names, and sum-

marization totals.

FIGURE 1.25
Design mode
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The wizard placed the following objects into appropriate places on the report:
Fields:

Country, ResortName
Groups:

Group #1 Name: This is the group created on the Country field.
Summary:

Count of Country: This is the summarization on the Country field.
Text Labels:

Country (field name), ResortNName (field name), and Grand Total
Graphic Elements:

Single underline beneath each group name

Single underline beneath the last item in each group

Double underline beneath the Grand Total

AUTOMATIC FIELDS

Also notice in Figure 1.25 that Crystal added some additional information that you did not request
while you were working through the Report Creation Wizard. Namely, the following two piece of
information were automatically added to the report for you:

¢ Print Date
¢ Page Number

Print Date is a variable that shows the date the report was displayed on the screen or printed to a
printer. Page Number is a variable that, as you would expect, displays the sequential page number
currently being viewed.

Sections

How did Crystal know where to place the variety of elements it created during report generation? It
followed some simple rules regarding section bands. Crystal Reports is known as a banded report writer.
It has five basic bands, or sections, that information can be added to in a report. When you use the
Report Generation Wizard, Crystal adds information to the appropriate band based on the element’s
type. Once the report is generated, you can make changes to the placement that Crystal set up for you.
The five basic bands represent physical layout areas on a piece of paper, and their purposes are

described in Table 1.4.
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TABLE 1.4: FIVE BASIC REPORT BANDS

BAND NAME DESCRIPTION EXAMPLES OF ELEMENTS

Report Header Items placed in this section appear once per report; the Report title
information is placed at the very beginning of the report.

Page Header Items placed in this section appear once per page and on Column headings, print date
every page of a report; the information is placed at the very
beginning of the page.

Details Items placed in this section repeat for each data record Fields

retrieved from the data source.

Report Footer Items placed in this section appear once per report; the Grand totals
information is placed at the end of the Details section.

Page Footer Items placed in this section appear once per page and on Page number
every page of a report; the information is placed at the end
of the page.

From the above descriptions, you'll notice that the Page Footer appears after the Report Footer.
This is indeed correct. The information placed in the Report Footer appears at the end of the data
from the Details section. Imagine a page that has data only to about the one-third of the page mark.
At that point, the Report Footer prints. The Page Footer, on the other hand, appears at the very end
of the page in the last inch of the printable area. Figure 1.26 shows the bands as they relate to their
physical layout on a piece of paper.

FIGURE 1.26
The five basic bands Report Header
Page Header
Details
Report Footer
Page Footer
ADDITIONAL SECTIONS

In addition to the five basic bands, or sections, two additional sections are added for each group that
you create. We added one grouping based on the Country field, so our report shows a header and
footer band for that group:

¢ Group Header #1: Resorts.Country-A
¢ Group Footer #1: Resorts.Country-A
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As with the other header and footer areas, items placed in the header area appear above the group,
while items placed in the footer area appear below the group.

SECTIONS IN DESIGN MODE

In Design mode, the five basic section bands appear anchored to the left side of the screen and next
to the design layout area. Additional header and footer bands appear for each group created, as shown
in Figure 1.27.

FIGURE 1.27

Feport Header
Design mode Page Header

sections

Group Header #1:
Fiesortz. Country - &

D etails

Group Footer #1:
Fiesortz. Country - &

Fieport Footer

Fage Foater

SECTIONS IN PREVIEW MODE
In Preview mode, a section band appears to the right of the group tree and to the left of the actual
data in the preview area. The names of the band may appear abbreviated, such as PH for Page Header
and GH1 for Group Header #1, or will display with their complete names.

For each group added, an incrementing number identifies the group. The report we're creating has
only one group, so you see GH1 and GF1 for Group Header #1 and Group Footer #1 repeated for

each new country. Remember that Country was the field upon which we based our group.

Toolbars and Menus

Good Windows applications are consistent, and Crystal Reports is a good Windows application. It
conforms to the standards of having a title bar at the top, a menu beneath the title bar, and toolbar
icons below the menu. Table 1.5 describes what each of these areas do for you, and Figure 1.28 dis-
plays them.

TABLE 1.5: GOOD WINDOWS CONVENTIONS

AREA NAME PURPOSE
Title bar Every window should have a title; it displays the name of the application, in this case, Crystal
Reports, and the name of the current object, in this case, the report name.

Menu Contains drop-down text-based navigation to the tasks that can be performed in the application;
the first two and last two menus are standard in most applications: File, Edit, Window, and Help.

Toolbar Contains shortcut icons to menu items; moving the mouse slowly over the icon displays a short
tool tip in text to describe the task performed by the icon.
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Crystal Reports follows the typical Windows convention for changing the menu options and tool-
bar options available at any given point by displaying context-appropriate options.

FIGURE 1 28 Px: Crystal Reports - [Report10]
: [E] File Edt Yiew [nsert Format Dacsbase Repot Window  Help =18 %
Toolbars and menus |0 B8R & 7|4 6o - o - =D E o dfor o) e |
|1 d =4 éfezr o= (a2 -E-=a @ % & &

]ah{EEE.EﬁENHﬂ!|
| Heg A E|Sa s

TiP  You can drag and drop the toolbar sections alongside one another and reorder them; click very near the left edge of the
section you want fo move fo select it.

Putting On the Finishing Touches

At this point, the report we created answers the business question of how many resorts VistaNations
has in each country and the names of the resorts. We can make the report a little more visually appeal-
ing by making some simple changes and using some basic graphic elements. This will also give you a

chance to use the design interface, toolbar, and menus a bit.

Indenting Groups

One of the first and easiest enhancements to make is to indent the detail data beneath a group name.
By default, Crystal left-aligns the group name and the data. You can easily change this by doing the

following:
1. Click the Design tab.
2. Click the Country field in the Details section.
3. Press the right arrow key twice to indent the field data.
4. Click the Preview tab to see the effect of your change.

The group data should now display indented, as shown in Figure 1.29.

FIGURE 1.29 5/13/200:
Indented group data Country Resartiame
Andorra
Andorra La Dorada Club T arter
1 Andorra
Antilles
Antilles Club Flamingo
1 Antilles
Argentina
Argentina Crystal Suites Apartments
1 Argentina
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Boxes and Lines
Lines and boxes can be added around text labels and fields to call attention to a particular area of the
report. In our report, we'll draw a box around the two column headings, Country and ResortINName,

by doing the following:
1. Click the Design tab.
2. Choose Insert > Box.

3. Use the pencil drawing tool to draw an outline box around the two column headings in the

Page Header.

The result is shown in Preview mode in Figure 1.30.

FIGURE 1.30

| Country ResortMame |
Drawing boxes

TIP  Another simple visual gj‘e[t is to add a line by fkoosing the menu options Insert > Line.

Pictures

One of the easiest ways to make your reports look more professional is to add a picture image. Let’s

add the VistaNations logo to the Page Header so that it appears at the top of every page in the report.
The VistalNations logo exists in a TTF image file. To add a graphic to the page header, do the

following:
1. Click the Design tab.
2. Choose Insert > Picture.
3. Locate and select the image using the Open menu.
4. Click the mouse inside the Page Header section to anchor the image.

Table 1.6 shows the types of graphics that can be placed in a Crystal report.

TABLE 1.6: TYPES OF GRAPHICS

FILE EXTENSION MEANING

.BMP Microsoft Windows bitmap format

.WMF Microsoft Windows Metafiles

.TIF Tagged Information File format; also known as TIFF images

.JPG Joint Photographic Expert Group format; also known as JPEG images

.PNG Portable Network Graphics format
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The result of adding the graphic can be seen by previewing your work, as shown in Figure 1.31.

FIGURE 1.31
Adding a graphic /_‘lr; QN“I%

5132002

Country Eesorttame

Resizing and Moving Objects

When Crystal adds fields and text to a report, it adds them in a default size that may or may not
completely display the object. Notice the Print Date variable that was automatically added, as shown
in Figure 1.32. You can see that the last letter appears to be cut off in Design mode and would dis-
play truncated in Preview mode as well.

FIGURE 1.32
Print Date variable Print Daté

You can fix this by manually resizing the field area using the object resize handles shown in Figure
1.33. These handles are shown as very small squares centered on each border of the object. Moving
your mouse over the square displays a two-headed arrow, signaling that you can drag and drop the
border to resize the object.

FIGURE 1.33
Object resize handles ri n?D at a

/////l-'////

With an object selected and the object resize handles visible, you can reposition the object in the
design or preview windows using drag-and-drop techniques. The resize symbol is an intersection set
of two double-headed arrows. When you see this symbol, you can drag and drop the object to move
it any piace in the report, including to different sections.

Saving a Report

We've done a good deal of work on this report. Let’s save what we've done so that we can use it later.
Saving a Crystal Reports file in the Windows environment is like saving any other type of file. Reports
are saved in a file with an .RPT extension. To save a report, use the menu sequence File > Save. A Save
As dialog opens to prompt you to provide a filename and automatically sets the type as Crystal Reports.
We'll save this report as CHO1.RPT. You can save it to any location accessible to your computer.

WARNING  Files created with Crysml Reports 9 cannot be opened with older versions of Crysml Reports.
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A WORD ABOUT REPORT NAMING CONVENTIONS

Small companies may have just a few reports, while large companies may have hundreds of reports. It is a
good investment of your time to sit down with the IT (Information Technology) folks in your organization
and agree on some report naming conventions.

Each Crystal report is stored in an operating system file that has an . RPT extension. Some companies embed
information in the name of a report; for instance, D582-CM.RPT is a report created in Department 582 by
someone with the initials CM. Another convention might involve the content of the report, for instance,
Employee Sales.RPTorMonthlyProjections.RPT.(Checkwith your operating system rules before using
blank spaces in filenames.)

Before you decide on conventions, consider the operating systems and devices to which you will be
deploying reports. Many operating systems, including Microsoft’s, allow long filenames, which means that
you can make the portion of the filename that comes before .RPT very robust and meaningful and include
spaces. Other operating systems, such as Unix, prefer the 8.3 (pronounced eight-dot-three) naming conven-
tion, or short filename, where the number of characters that comes before the period should be eight or
fewer. Similarly, small handheld devices, such as cell phones, can store less information and have smaller
output displays, so short filenames might be easier to manage.

Agreeing on a good naming convention early in the process will help you find your reports more easily
later on!

The Business Questions Answered

The simple report shown in Figure 1.34 and created in this chapter shows that there are a total of
201 resorts in VistaNations’ inventory, with 94 of them being in the United States and the remain-
der spread out in smaller groups around the world. The report has a total of 9 pages. Further, it's an
attractive document that is easy to read.

FIGURE 1.34 us Sunterra Pacific
Last page of the
pag 94 us
report
Venezuela
Wenezuela M argarita International
Wenezuela Las Olas Resort
2 Venezuela
Wales
Walaes Flas Talgarth Health &
1 Wales
West Indies
West Indies M arlin Guay
West Indies Southwinds Beach
2 West Indies
Grand Total: 201




SUMMARY 29

Summary

As you've seen in this chapter, creating a report with Crystal Reports is easy. Creating a good report,
however, requires that you understand how to connect to the data, retrieve the pieces you need, and
lay them out in an aesthetically pleasing and meaningful way. A solid understanding of your report-
writing tool is essential.

The five basic sections, or bands, of a Crystal Report play a large role in the ultimate look, feel, and
behavior of a report. The report wizard places fields and text automatically in appropriate sections, and
with a little background information on why the wizard does what it does, you can confidently move
data around to make the layout work for you. The Standard Report Creation Wizard helps you perform
summarization and grouping during the first stages of report writing, which is where you start the
process of converting raw data into meaningful information.

Beyond the wizard approach to building a report, you can add visual elements to a report, which
can go a long way in delivering quality reporting. While you can't change the news the data delivers,
sometimes the news is easier to swallow if it at least looks organized and neat in the report! We'll
continue working with this report in the next chapter as we move beyond the Report Creation Wizard
to additional Crystal Report features.








